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MICRONAIR SPRAYTRAC GPS TRACK GUIDANCE SYSTEM 

1. INTRODUCTION 
The Micronair Spraytrac GPS track guidance system is designed specifically for 
use on ground vehicles used for the control of locusts and other migrant pests.  
The purpose of the system is to provide precision guidance to enable the driver 
to follow parallel spray tracks and also to record the position of the vehicle and 
the status of the sprayer.  Spray jobs can be viewed, printed and archived on an 
office or laptop computer using Micronair Spraymaps software. 
 
All parts of the system have been designed for maximum simplicity and ease of 
use. 
 
In addition to providing track guidance, the system displays GPS latitude and 
longitude coordinates.  These can be used for survey purposes, thus eliminating 
the need for a separate hand-held GPS receiver. 
 
The system consists of two main parts: 
 

1.1 Spraytrac Vehicle Mounted Equipment 

The equipment installed on each spray vehicle consists of: 
 A Spraytrac guidance unit, installed above the vehicle dashboard in view of 

the driver.  The unit incorporates a LCD display screen and operator controls 
and can easily be removed from its mounting bracket when not required.  The 
Spraytrac software is designed to provide a very simple user interface and is 
suitable for use by personnel who may not have any prior experience of 
computers or more complex GPS devices.  Operation of the system is by an 
on/off switch and four touch-sensitive buttons, one of which is dedicated to 
showing help messages on the screen.  Whilst in the spray area, the screen 
shows a perspective image of the spray tracks and the driver need only 
follow a line on the display to remain on the correct track.  The position of the 
vehicle is continuously logged without any operator intervention for the entire 
time that the Spraytrac unit is switched on.  The log file is retained in the 
memory of the unit until it is downloaded for analysis and archiving by the 
Micronair Spraymaps program on an office PC or a laptop computer.  Text on 
the Spraytrac display can be in English, French or Arabic. 

 A self-contained GPS receiver and antenna.  This is secured to the roof of 
the vehicle cab by a magnetic mounting and can be removed and 
disconnected when not in use. 

 A fixed installation kit for the vehicle.  This consists of a mounting bracket for 
the Spraytrac unit and electrical wiring for the power supply from the vehicle 
battery etc.  The wiring includes an optional connection to the sprayer to 
allow the Spraytrac log file to record the locations at which the sprayer pump 
is operating. 

 An optional back-up battery pack to provide power to the Spraytrac unit 
during interruptions in the supply from the vehicle battery (eg during an 
engine start). 

 A USB flash memory key to download the log file from the guidance unit and 
to transfer this to an office PC or laptop computer. 
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Fig. 1 – Components of System 
 
 

1.2 Spraymaps Software 

Micronair Spraymaps is a software package that can be installed on any desktop 
or laptop PC running a Windows operating system.  The Spraymaps program is 
designed to: 
 Transfer log files from Spraytrac units in vehicles, using a USB flash memory 

key. 
 Analyse each log file and divide it into individual spray jobs, based on the 

date and time of the records. 
 Store individual job records in an archive.  This archive held on the hard disk 

of the PC or on a network file server.  The archive is structured to allow easy 
retrieval of records for multiple spray vehicles by vehicle name, date and 
time. 

 Enable entry of additional job data and notes in each job record. 
 Retrieve, display or delete individual job records.  The display shows both a 

visual representation of the vehicle track (together with spray on/off 
information, if applicable) and a summary of the job statistics. 

 Print a job report comprising an image of the vehicle track and a summary of 
the job statistics. 

 Convert job files to Shapefile and CSV format for import into a user’s existing 
GIS database (optional). 

 Create the configuration files used to upload set-up parameters (language, 
vehicle name etc) to individual Spraytrac units, using a USB flash memory 
key. 
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2. SPECIFICATION 

2.1 System Unit 

Dimensions: 135 mm W x 90 mm H x 60 mm D (less mounting 
bracket). 

Weight: 0.6 kg. 
Mounting: By adjustable bracket secured to vehicle.  System 

unit can be detached from bracket when not required 
in vehicle. 

Operating temperature: -10ºC  –  +35º C ambient. 
Input Voltage: 9 – 15 V DC. 
Input Current: 350 mA max. 
Operating system: Linux. 
Data (log file) memory: 2 GB. 
Display: Back-lit dot-matrix LCD with contrast control.  Display 

optimised for viewing in both direct sunlight and low 
light conditions. 

Controls: Power on/off switch, display contrast adjustment and 
four touch-sensitive input buttons. 

Display language: English, French, Arabic with Hindi numerals or Arabic 
with Western numerals (operator selectable). 

Sprayer interface: Optional connection to Micron Ulvamast or Micronair 
vehicle-mounted sprayers to allow logging of 
operation of sprayer pump. 

Environmental protection: IP 51. 
 
 

2.2 GPS Receiver 

Dimensions: 61 mm diameter x 20 mm high. 
Weight: 0.2 kg. 
Cable: 5 m long with quick-disconnect connector. 
Mounting: By magnetic base or optional M3 screw fitting. 
Power supply: From Spraytrac unit (no separate power supply 

connection required). 
Update rate: 5 Hz 
Differential correction: WAAS/EGNOS (where available) 
Environmental protection: IP 67. 
Operating temperature: -30ºC  –  +80ºC. 
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2.3 Spraymaps Software 

Configuration: One Spraymaps program can support an unlimited 
number of vehicle systems, although multiple copies 
of the software can be installed if required. 

Software licence: The software licence is granted per customer and 
does not limit the number of copies of the program 
installed by a single customer. 

Language: Program interface, job data display and job printouts 
in English or French (language chosen during 
program installation). 

PC specification: User-supplied desktop or notebook PC running 
Windows operating system (Windows 2000, XP, Vista 
or 7) with one available USB port. 

Disk space required: Minimum 1 MB free disk space for program and 1 GB 
per 1000 hours of total logged spray records (log files 
can be stored on the local hard disk or on a network 
server or NAS device). 

PC monitor: User-supplied monitor with minimum 1024 x 768 DPI 
resolution. 

Printer: User-supplied monochrome or colour printer (A4 
page size). 

 
 

3. SPRAYTRAC SYSTEM 

3.1 Installation & Initial Configuration 

3.1.1 Mounting of Spraytrac Unit 

The Spraytrac unit should mounted on the top surface of the dashboard of the 
vehicle, using the mounting bracket and hardware provided.  The position should 
be chosen so as to be in the direct line of sight of the driver without obstructing 
his view ahead of the vehicle.  The position should also allow easy access to the 
controls on the front panel.  The front panel should be as close to perpendicular 
to the driver’s line of sight as possible and it may be preferable to mount the unit 
at an angle to the line of the dashboard (see Fig. 2). It is important to allow 
adequate clearance between the back face of the unit and the windscreen to 
avoid the risk of damage due to movement of the unit and contact with the 
windscreen when driving over rough terrain. 
 
The procedure to mount the Spraytrac unit is as follows: 
1. Fit the mounting bracket to the unit by slackening the two knurled retaining 

knobs, sliding the threaded studs into the slots in the bracket until the 
retaining bushes snap into the circular cut-outs in the bracket and tightening 
the retaining knobs. 
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2. Identify the optimum position for the unit on the top face of the dashboard 
and mark around the outside of the bracket with a pencil. 

3. Remove the bracket from the unit by reversing step (1). 
4. Drill a minimum of two 4.5 mm diameter holes through the bottom face of 

the mounting bracket and into the top of the dashboard.  The position of 
these holes must be chosen to allow easy access from the underside of the 
dashboard and to avoid any wiring, instruments etc underneath.  Wherever 
possible, the existing holes in the bracket should be used.  If this is not 
possible, the outermost holes should be drilled as close as possible to the 
vertical lugs of the bracket. 

5. If the top surface of the dashboard is not sufficiently rigid to prevent 
vibration or movement of the unit, a stiffening plate should be installed 
under the dashboard.  The pre-drilled plate supplied with the system should 
be used if possible.  If an alternative arrangement is required, a plate 
should be cut from aluminium alloy or steel sheet with a minimum thickness 
of 1 mm.  Drill 4.5 mm dia holes in the stiffening plate as necessary to align 
with the holes drilled in step (4). 

6. Secure the bracket to the dashboard and stiffening plate (if fitted), using the 
M4 screws, nuts and washers provided.  The nuts must be on the 
underside. 

7. Install the unit on the bracket as described in step (1). 
 
 

 
 

Fig. 2 – Typical Installation in Cab of Vehicle 
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3.1.2 Installation of Fixed Wiring in Vehicle 

The wiring for the system must be permanently installed in the vehicle as shown 
in Fig. 3.  The length and routing of the cables and connectors should allow for 
easy removal of the system unit and GPS receiver when not in use.  The vehicle 
wiring loom is supplied pre-assembled and it should not be disassembled or 
modified. 
 
 

 
 

Fig. 3 – Schematic Diagram of Wiring (Without Battery Back-up) 
 
 
In order to provide a neat installation and to prevent possible damage to cables, 
as much of the wiring as possible should be routed under the dashboard or 
behind trim panels.  The installation procedure is as follows: 
1. Identify a route for the cables from the 15 pin Spraytrac unit connector to 

the area behind the dashboard.  If it is not possible to run these through an 
existing opening, it may be necessary to make a hole with a minimum 
diameter of 25 mm in an appropriate position.  The cut edge of the hole 
should be protected with a length of the grommet strip provided.  This 
should be secured in position with a suitable contact, epoxy or silicone 
adhesive. 

2. Identify a suitable earth (ground) point on the vehicle structure.  This must 
be part of the main structure of the vehicle and not be on a removable 
panel.  If possible, use an existing hole; otherwise drill a new 4.5 mm dia 
hole in part of the main vehicle structure.  Remove all paint within 5 mm of 
the hole and secure the tag on the black (negative supply) wire to the earth 
point, using either existing hardware or the M4 screw, nut and washer 
provided. 

3. Identify both the red (positive supply) wire from the Spraytrac loom and the 
red battery wire assembly provided.  Temporarily disassemble the two parts 
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of the in-line fuseholder on the battery wire and connect the ring tag on the 
wire from the fuseholder directly to the positive terminal of the vehicle 
battery.  Route the red wire from the opposite part of the fuseholder from 
the battery compartment to the location of Spraytrac unit.  Insert the 
connector blade on the red positive supply wire from the Spraytrac loom 
into the receptacle on the battery wire.  Re-assemble the in-line battery 
fuseholder and fuse. 

4. Route the GPS input cable and its blue connector to a position that 
provides protection but allows easy access to connect the cable from the 
GPS receiver when required.  A parcel shelf or similar location under the 
dashboard is preferred. 

5. Identify a suitable position for the USB socket.  This should provide easy 
access to insert a USB memory key when required but should also provide 
protection from dust and moisture when the connector is not in use.  The 
preferred location is in the glove compartment under the dashboard.  If 
necessary, drill a 25 mm diameter hole for the cable and connector and 
protect this with grommet strip as described in step (1).  Route the cable 
with the USB socket to its final position.  Do not attempt to cut, join or 
extend the USB cable as this would impair its electrical properties and 
could cause errors during data transfer. 

6. If the system is to be used to log the operation of the pesticide pump on the 
sprayer, it is necessary either to make a connection to the positive supply to 
the pump or to install a pressure switch to detect pressure in the feed to the 
spray atomiser when the pump is running.  If a pressure switch is to be 
fitted, the appropriate installation kit must be ordered separately for the 
model of sprayer being used.  Options for the connection to a sprayer are 
as follows: 
i. Direct connection to pump – identify the white 3-pin plug housing and 

the white sprayer input wire provided.  Insert the pin on the white wire 
into the centre hole (pin 2) of the plug housing.  The pin must enter the 
housing from the narrow end and be pushed in until it snaps into place.  
Connect the plug to the corresponding 3-pin socket on the Spraytrac 
loom and route the free end of the white wire to the sprayer installed in 
the rear of the vehicle.  Ensure that this wire is protected from damage 
along its entire length.  Wherever possible, the wire should be routed 
alongside the existing sprayer cable and passed inside the flexible 
conduit to the junction box on the sprayer.  Connect the wire to the main 
sprayer cable at the terminal block inside the sprayer junction box as 
follows: 
 Ulvamast V3M – To green/yellow wire 
 Ulvamast V3E – To green/yellow wire 
 Micronair AU8115M – To red wire 
 Micronair AU8115E – To red wire 

ii. Using a pressure switch – identify the 3-pin plug housing and both the 
white and pink sprayer input wires provided.  Insert the pin on the white 
wire into the centre hole (pin 2) and the pin on the pink wire into the hole 
adjacent to the V-shaped end (pin 1) of the plug housing.  Connect the 
plug to the socket on the Spraytrac loom and route the free ends of the 
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wires to the sprayer as described above.  Install the pressure switch on 
the sprayer and connect the pink and white wires to the switch terminals 
as described in the leaflet supplied with the pressure switch kit. 

7. Secure all wires installed in steps (1) – (6) above, using the cable ties 
provided.  Particular care must be taken to secure and protect wires inside 
the engine compartment, any exposed wires to the sprayer in the rear of 
the vehicle and wires adjacent to sharp edges.  Any excess lengths of wire 
should be coiled up and secured with cable ties. 

 
 

3.1.3 Installation of Optional Back-up Battery Pack 

The Spraytrac unit requires a supply of at least 9 V to operate correctly.  If the 
supply voltage from the vehicle battery falls below 9 V, the unit will shut down 
and then attempt to re-start.  On some vehicles, the battery voltage will fall below 
9 V whilst the engine starter is engaged (particularly if the battery is in poor 
condition).  This will result in the termination of the current spray job and the 
starting of a new job if, for example, the vehicle engine stalls during a spray job 
and is re-started. 
 
If this condition is encountered, it is recommended that the optional back-up 
battery pack (EX7136) should be installed.  This is connected to the power 
supply input to the Spraytrac unit contains eight AA (LR6) size dry batteries to 
maintain a minimum supply of 12 V, even if the vehicle battery falls below this 
level for a short time.  The batteries are isolated from the Spraytrac unit at all 
other times and are not, therefore, discharged during normal operation. 
 
 

 
 

Fig. 4 – Schematic Diagram of Wiring (With Battery Back-up) 
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The battery pack should be installed in a convenient location that allows easy 
access to change the batteries when necessary.  Suitable locations include the 
glove compartment or parcel shelf in the cab. 
 
The battery pack is connected as shown in Fig. 4. 
 
The battery pack is supplied without batteries.  It must be fitted with eight AA 
(LR6) size alkaline cells before use.  Only alkaline batteries should be used.  
Rechargeable batteries (NiCd or Ni-MH types) provide a lower voltage and are 
not suitable.  Carbon-zinc batteries are unsuitable for long-term use and are 
prone to leakage. 
 
The procedure to install batteries is as follows: 
1. Remove the two knurled lid securing nuts and remove the lid. 
2. Extract the battery holder and remove and discard any batteries already 

installed. 
3. Fit eight new batteries, following the polarity markings on the battery holder. 
4. Replace the battery holder, lid and securing nuts. 
 
It is essential that all eight batteries are replaced at the same time. 
 
The batteries should be removed from the battery pack if the system is not to be 
used for a prolonged time or if the vehicle battery is disconnected.  The battery 
pack is not intended to power the Spraytrac unit continuously if the vehicle 
battery is not connected. 
 
 

3.1.4 Mounting of GPS Receiver 

The GPS receiver must be installed on the vehicle only when required.  It should 
be removed when the system is not in regular use. 
 
The receiver has a magnetic base that attaches directly to a flat steel surface.  If 
the receiver is to be mounted on a non-metallic cab surface, a round or square 
piece of steel plate approximately 100 mm across and at least 1 mm thick can be 
fitted to provide a mounting for the receiver.  This plate can either be attached 
with screws or can be bonded to the underlying surface with an epoxy adhesive.  
If screws are used, these must either have countersunk heads or be positioned 
outside the diameter of the receiver casing so as to provide a flat surface for the 
magnet. 
 
In some vehicles the receiver will perform satisfactorily if it is mounted above the 
dashboard of the vehicle inside the windscreen.  If the Spraytrac display shows 
ACQUIRING GPS continuously after it is switched on or NO GPS DATA during 
operation, this indicates that the strength of the GPS signal inside the vehicle is 
insufficient and the receiver should be mounted on the upper surface of the roof 
of the vehicle cab as shown in Fig. 5.  The exact position on the roof is not 
important, provided that the surface is horizontal so that the receiver faces 
directly upwards.  The receiver should not be installed on the bonnet (hood) or 
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on the rear bed of the vehicle as the cab would obstruct the antenna’s view of 
the sky. 
 
The cable from the receiver to the vehicle cab must be protected from damage 
due to contact with sharp edges, by pinching or by excessive movement.  Under 
no circumstances should the cable be routed through a cab door opening or 
through the window in a door.  The preferred routing is through a window at the 
rear of the cab or through a hole in the cab structure.  If a new hole is cut, it 
should have a minimum diameter of 20 mm to accommodate the connector on 
the receiver cable and care must be taken to ensure that the hole is positioned 
so as to minimise the entry of dust or rain.  Any sharp edges at the point of entry 
must be protected by fitting a piece of the grommet strip provided. 
 
After fitting the GPS receiver, its cable and connector must be routed to the 6 pin 
GPS input connector on the Spraytrac loom.  After assembly, the two parts of the 
connector must be secured with the blue locking ring. 
 
The cable should be routed so as to minimise any slack length outside the 
vehicle and to avoid movement or chaffing whilst driving at speed.  Also, the 
cable should be positioned inside the vehicle so as to avoid accidental damage 
from being stepped upon or pulled by the occupants of the cab. 
 
 

 
 

Fig. 5 – Typical Mounting of GPS Receiver on Cab Roof 
 
 

3.2 Display & Controls 

Throughout this handbook the names of controls and button icons on the 
Spraytrac unit are shown in CAPITALS and text on the display is shown in 
BOLD ITALIC CAPITALS. 
 
The display and controls of the Spraytrac unit are all mounted on the front panel 
as shown in Fig. 6. 
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 Display – the liquid crystal display is designed for maximum clarity under a 
wide range of lighting conditions, including direct sunlight.  The display is 
back-lit to ensure good visibility in a low light. 

 DISPLAY CONTRAST control – adjusts the contrast of the display to suit 
the viewing angle and the ambient lighting conditions.  Rotating the knob 
clockwise darkens the image on the display and rotating it anti-clockwise 
lightens the image.  Note that the display can appear completely blank if the 
control is set to the extreme anti-clockwise position or completely black if the 
control is rotated fully clockwise. 

 Touch buttons – the operation of the unit is controlled by four touch buttons 
to the right hand side of the display.  The function of each button is indicated 
by the corresponding icon at the edge of the display; see section 3.3 for full 
details.  These buttons are touch sensitive and do not require pressure to 
operate.  In order to avoid accidental operation, there is a time delay between 
touching a button and the system responding.  This delay can be changed by 
the user if required – see section 4.8.  Note that the buttons require the close 
proximity of a finger to operate and they will not function if touched with a 
non-conducting object such as a pen or when wearing thick gloves. 

 
 

TOUCH
BUTTONS

DISPLAY
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CONTROL

POWER
ON/OFF
SWITCH

LCD
DISPLAY
SCREEN

 
 

Fig. 6 – Front Panel of Spraytrac Unit 
 
 

3.2.1 Initial Test & Configuration 

After installation, carry out a functional test as follows: 
1. Press the POWER  button once so that it latches in the IN position.  The 

backlight of the display should illuminate. 
2. After about 15 seconds the display should show the Micronair logo and 

then the message ACQUIRING GPS and a moving progress bar.  Adjust 
the DISPLAY CONTRAST control for the clearest display. 
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3. Wait for the ACQUIRING GPS message to disappear and for the display to 
change to initial guidance mode (see Fig. 8).  This may take 1 – 2 minutes if 
the GPS receiver is being used for the first time in a new location as it must 
acquire a new almanac of the GPS satellites and store this in its internal 
memory.  Note that the GPS receiver must have an unobstructed view of 
the sky to function correctly.  It will not receive signals from the GPS 
satellites if it is used under a metal roof or immediately adjacent to a tall 
building.  In these cases, the display will show ACQUIRING GPS 
indefinitely. 

4. Press the POWER  button once so that it latches in the OUT position.  
The display should change to SHUTTING DOWN and the display and 
backlight should extinguish after about 2 seconds. 

5. If the GPS unit is being installed on a particular vehicle for the first time, it 
must be configured for the name or number of the vehicle on which it is 
being used and for the appropriate operating parameters.  The 
configuration parameters are set using the Micronair Spraymaps software 
and transferred to the Spraytrac unit in the vehicle using a USB flash 
memory key.  See sections 3.3.10 & 4.8 for full details. 

 
 

3.3 Operation 

3.3.1 General Principles 

The Spraytrac GPS track guidance system is intended to enable the driver of a 
spray vehicle to follow parallel tracks in a spray block.  The layout of a typical 
spray block is shown in Fig. 7.  The key features are: 
 Spray tracks – the spray tracks should be aligned at approximately 90º to 

the direction of the wind and the first track must be at the downwind edge of 
the spray block. 

 Track spacing – the spray tracks must be parallel and at a constant distance 
apart.  This distance is defined as the track spacing and will depend upon the 
type of sprayer being used and the wind speed. 

 First track – the first spray track along the downwind edge of the block 
determines the orientation of all the subsequent parallel tracks.  When 
spraying along the first track, the vehicle is driven from a point at the 
beginning of the block (point A) to a point at the end (point B).  These points 
may be defined by physical features (a road, trees etc) or may be marked by 
flags etc.  Because the first track is between points A & B it is also known as 
the A - B line. 

 Ends of block – if the spray block is rectangular, the ends of the block are 
defined by lines projected from the A & B points at 90º to the first track. 

 Return point – it may be necessary to leave the spray block to re-fill the 
pesticide tank or to refuel etc.  In this case it is important that the vehicle 
should return to the point where spraying stopped so that it can continue 
along its original track.  The point where the vehicle stops spraying before 
leaving the area is defined as the return point. 
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1 – Vehicle leaves filling area, drives to spray block and commences spraying 
2 – Vehicle returns to filling area to re-fill pesticide tank or to re-fuel 
3 – Vehicle drives back to marked return point and continues spraying 

 
 

Fig. 7 – Layout of Typical Spray Block 
 
 

3.3.2 Preparation for Use 

The Spraytrac unit can be switched on either when the vehicle leaves its base or 
when the vehicle arrives in the spray area, before spraying commences.  In both 
cases, the position of the vehicle is recorded (logged) in the Spraytrac memory 
for the entire time that the unit is switched on.  The location at which the 
Spraytrac unit is switched on must be decided according to local requirements.  
Factors to consider are: 
 Switch on at base – the track of the journey to the spray area is recorded in 

addition to the track within the area.  This results in a larger log file and a 
longer track displayed by the Spraymaps program.  However, it provides a 
full record of all the vehicle’s movements.  The start time shown on the 
Spraymaps job summary is the time at which the vehicle moves away from 
the base (see section 4.3). 
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 Switch on in spray area – the record of the track begins when the vehicle 
first starts to move in the spray area.  This results in a smaller log file and a 
more compact Spraymaps track display.  The start time on the job summary 
is the time at which the vehicle begins to move in the spray area. 

 
To switch the unit on, press the POWER  button once so that it latches in the 
IN position.  The display backlight should illuminate immediately and after about 
15 seconds the display should show the Micronair logo, followed by the message 
ACQUIRING GPS and a moving progress bar.  Adjust the DISPLAY 
CONTRAST control for the clearest display. 
 
After the GPS receiver has acquired all satellites in view, the display will change 
to the initial guidance mode as shown in Fig. 8.  This shows the following 
information: 
 Position – latitude and longitude.  This can be displayed in decimal degrees 

or in degrees, minutes and decimal seconds.  The display format is 
determined by the configuration of the unit and can be changed – see section 
4.8. 

 Speed and heading – note that the heading is only valid whilst the vehicle is 
moving. 

 Track spacing – this is the distance between spray tracks in metres.  When 
the unit is switched on, the track spacing shown on the display is the same as 
that used for the previous spray job (or is the default value if the configuration 
has just been updated).  If the spacing shown is correct for the current job, it 
is not necessary to change it.  If necessary, the procedure to change the 
track spacing is as follows: 
i. Touch the button alongside the TRACK SPACING numerals on the 

display.  After a short delay, the display will change to show upward and 
downward pointing arrows   above and below the track spacing – see 
Fig. 9. 

ii. To increase the track spacing, touch the button alongside the upward 
pointing arrow .  A single touch will increment the spacing by 1 m.  A 
prolonged touch will cause the track spacing to increment continuously.  
The rate at which the display increments can be changed in the Spraytrac 
configuration – see section 4.8.  To decrease the track spacing, touch the 
button alongside the downward pointing arrow . 

iii. When the correct track spacing is shown, touch the TRACK SPACING 
button again until the  and  arrows disappear. 

 HELP button (?) – touching this button at any time will display a short help 
message explaining the actions that can be taken in the current context.  The 
message disappears when this button is released. 
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Fig. 8 –Initial Guidance Display 
 
 

INCREASE
SPACING

TRACK
SPACING

DECREASE
SPACING

 

 

Fig. 9 – Setting of Track Spacing 
 
 
 
 

3.3.3 Setting the First Spray Track 

The first spray track is defined by a line between a point at the beginning of the 
block (point A) and a point at the end of the block (point B) – see Fig.7.  The 
procedure to set this track in the Spraytrac unit is as follows: 
1. Drive the vehicle to the beginning of the first track (point A). 
2. Touch the BEGINNING OF TRACK button  (denoting a flag at the start of 

the block) – see Fig. 8.  The icon alongside this button will change to  
(denoting a flag at the end of the block – see Fig. 10).  Note that the vehicle 
can be moving or stationary when the button is touched. 
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3. Drive the vehicle to the end of the first track (point B), with the sprayer 
operating as required.  Whist driving, the display will show the speed and 
heading of the vehicle and the distance from the beginning of the track 
(point A) as shown in Fig. 10.  This information can be used to locate the B 
point is there is no physical marker. 

4. At the end of the first track (point B), touch the END OF TRACK button .  
The icon will change to .  Note that the vehicle can be moving or stationary 
when the button is touched.  In order to prevent an accidental touch of the 
button from setting the B point in the same place as the A point, the vehicle 
must move a minimum distance from the A point before the B point can be 
set.  The default distance is 20 m, but this can be changed – see section 
4.8.  If the button is pressed before the minimum distance is reached, the 
display will show INSUFFICIENT DISTANCE FROM FIRST POINT and the 
point will not be set. 

 
After setting the B point at the end of the track, the display will change to track 
guidance mode – see Fig. 11. 
 
In case of an error after setting the A point, the procedure can be aborted and re-
started as follows: 
1. Touch the ABORT JOB  button until the display returns to the initial 

guidance mode.  Note that the delay before the system responds to this 
button is four times longer than the Button Delay configured for other 
buttons.  This is to reduce the risk of an operator aborting a job by touching 
this button accidentally. 

2. Drive the vehicle back to the beginning of the first track (point A) and repeat 
steps (1) – (4) above. 
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Fig. 10 – Display Whilst on First (A-B) Track 
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3.3.4 Subsequent Spray Tracks 

After the first spray track has been defined, the system provides guidance along 
subsequent parallel tracks, which may be either to the left or to the right of the 
first track. 
 
Whilst in the spray area, the display is in track guidance mode as shown in Fig. 
11.  This shows the spray tracks ahead of the vehicle in a perspective view, with 
each track appearing as a line for the driver to follow.  The display shows the 
following information: 
 The current spray track – shown as a dashed line. 
 Adjacent spray tracks – the five parallel tracks on each side of the current 

track are shown as solid lines. 
 Position arrow – the position of the vehicle relative to the tracks is shown as 

an upward pointing arrow  at the bottom of the display.  The objective of 
the driver is to keep the dashed line (denoting the current track) aligned with 
this arrow. 

 Track number – shown under the position arrow.  The first track (A-B line) is 
shown as 01 and subsequent tracks are numbered incrementally (02, 03, 04, 
05...). 

 Track spacing – the current spacing in m. 
 Ends of block – the beginning and end of the spray block (as defined by 

lines projected from the A & B points perpendicular to the A-B line) are shown 
by dotted lines perpendicular to the tracks on the display.  Note that these 
lines come into view only when the vehicle is about 150 m from the end of the 
block.  When the vehicle is further away from the ends of the block, its 
location relative to the block is shown by the in/out of block indicator – see 
below. 

 In/out of block indicator – when the vehicle is inside the spray block and is 
close to the current track (within ±1 track width), the indicator at the left hand 
edge of the display shows two solid arrows .  If the spray block is ahead of 
the vehicle the indicator shows a single arrow pointing upwards .  If the 
spray block is behind the vehicle the indicator shows a single arrow pointing 
downwards . 

 Turn direction indicator – a horizontal arrow  or  at the left hand edge 
of the display shows the direction of the turn onto the next track relative to the 
current track of the vehicle.  If the arrow is pointing to the left, the next turn 
will be to the left and vice-versa.  Note that this arrow is only shown when the 
vehicle is close to the current track (within ±1 track width) and is following the 
track to within ±10º.  The indicator disappears when the vehicle begins to turn 
so as to avoid confusion for the driver. 

 Vehicle speed – the current speed in km/h. 
 Spray on/off indicator – this represents the spray atomiser and appears as 

a square  when the spray is off and as a square with spray droplets  when 
the sprayer is operating.  Note that this indicator will only show SPRAY ON 
when the Spraytrac unit is connected to the sprayer (optional). 
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Fig. 11 – Track Guidance Display 
 
 
The procedure to follow tracks parallel to the first track is as follows: 
1. After setting the B point at the end of the spray block, continue driving along 

the first track for about 20 m (this distance can be reduced as the driver 
gains experience). 

2. Turn the vehicle in the direction of the second track.  Note that the direction 
of this first turn is important as it determines whether all subsequent tracks 
will be to the left or the right of the first track. 

3. As the heading of the vehicle passes through 90º to the first track, the track 
number on the guidance display increments from 01 to 02. 

4. Continue turning in the direction of the second track.  The dashed line 
representing this track will come into view on the display.  Steer the vehicle 
so that the position arrow aligns with the dashed line and the dashed line 
appears vertical on the display.  Avoid making sudden changes of direction 
and do not attempt to intercept the dashed line at too great an angle as this 
will result in ‘over-steering’ and overshooting the line. 

5. Continue steering the vehicle so that the dashed line remains aligned with 
the position arrow.  The objective of the driver is to ‘drive along the line’. 

6. Proceed along the line towards the spray block until the perpendicular 
dotted line indicating the beginning of the block line comes into view.  When 
the vehicle enters the block, the line disappears from the bottom of the 
display and the in/out of block indicator changes to two arrows .  Start 
spraying as required.  The SPRAY indicator will change to SPRAY ON  (if 
the Spraytrac unit is connected to the sprayer). 

7. Continue to follow the track until the perpendicular line indicating the end of 
the block comes into view.  When the vehicle leaves the block, the line 
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disappears from the bottom of the display and the in/out of block indicator 
changes to a downward pointing arrow , denoting that the block is behind 
the sprayer.  Stop spraying as required.  The SPRAY indicator will change 
to SPRAY OFF  (if applicable). 

8. Proceed about 20 m along the current line. 
9. Note the TURN DIRECTION (  or ) indicator to establish the direction of 

the turn onto the next track. 
10. Turn the vehicle onto the next track.  The track number will increment as 

the heading of the vehicle passes through 90º to the track and the dashed 
line on the display will move to the position of the next track. 

11. Continue turning and follow steps (4) – (10) above. 
 
 

3.3.5 Obstacles 

In many spray areas it will be necessary to deviate from the desired track to 
avoid obstacles such as trees, bushes, rocks, uneven ground etc.  In these 
cases, the procedure is as follows: 
1. Before reaching the obstacle, begin steering either to the right or to the left.  

Generally, the route around the obstacle should be chosen so as to 
minimise the deviation from the required track.  However, it may be 
advantageous to pass on the upwind side if the obstacle is also a habitat for 
the pest being controlled (eg locusts in bushes). 

2. Steer around the obstacle and back onto the original track (as shown on the 
display as a dashed line) so as to follow a smooth curve as shown in Fig. 7.  
Do not make any sudden changes in direction and avoid turning through 
90º to the original track.  A turn through 90º will be interpreted as a turn at 
the end of the spray block and the track number will increment to the next 
line. 

 
 

3.3.6 Marking a Return Point 

It may sometimes be necessary to leave the current track during a spray job to 
re-fill the pesticide tank, refuel the vehicle etc.  In these cases, it is necessary to 
mark the point at which the job was interrupted so that the vehicle can return and 
resume spraying from the same point.  The procedure to mark a return point and 
to drive back to it is as follows: 
1. Whilst the vehicle is still on the current spray track, touch the MARK 

RETURN POINT button  until the icon changes from an empty (white) flag 
to a filled (black) flag .  This indicates that the return point has been set.  
The return point can be set whilst driving or with the vehicle stationary. 

2. Note the heading of the vehicle. 
3. Drive the vehicle out of the spray area as required.  Note that the display 

will change from track guidance mode to orientation mode when the vehicle 
moves away from the return point – see Fig. 12.  The distance at which the 
display changes can be set via the Spraytrac configuration – see section 
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4.8.  When in orientation mode, the display will show the distance (in km) to 
the return point and a pointer will indicate the direction to the return point 
relative to the vehicle – see Fig. 12. 

4. Do not switch the unit off or touch the ABORT JOB  button whilst away 
from the spray area. 

5. When driving back to the spray area, follow the pointer  on the orientation 
display towards the return point.  The pointer will be vertical (towards the 
top of the display) when the return point is directly ahead and the display 
will show the distance to the return point. 

6. When the vehicle approaches to the return point (at the distance specified 
in the Spraytrac configuration), the display will change to track guidance 
mode and the dashed line representing the last spray track will come into 
view.  The return point will be indicated by a dotted line intersecting the 
dashed line – see Fig. 13. 

7. Drive onto the spray track and follow this to the return point, ensuring the 
vehicle is on the same heading as before (as noted in step (2) above). 

8. When at the return point, touch the RETURN POINT button until the filled 
(black) flag  changes to an empty (white) flag .  This indicates that the 
return point is cleared (ie no longer active).  The dotted line indicating the 
return point will disappear.  Start spraying as required and continue to 
follow subsequent spray tracks as described in section 3.3.4.  Note that it is 
very important to clear the return point when resuming the spray job.  If the 
return point is not cleared, the number and position of the spray track will 
not increment when the vehicle turns at the end of the spray block.  In this 
case, it will be necessary to drive back to the return point and to touch the 
RETURN POINT  button to clear the flag. 
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Fig. 12 – Orientation Display 
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Fig. 13 – Display When Approaching Return Point 
 
 

3.3.7 Starting a New Spray Job 

The Spraytrac unit generates an internal log file that records the position of the 
vehicle and spray on/off data.  This information is logged continuously for as long 
as the Spraytrac unit is switched on and is appended to any other information 
already stored in the unit’s log file.  Each time the unit is switched on, the vehicle 
is assumed to be working in a new spray block and the Spraymaps program will 
archive the details as a new job. 
 
If the vehicle sprays several different blocks during one trip, each block must be 
treated as a separate job, with a new A-B line set for each.  There are two 
options to start a new job: 
1. Switch the Spraytrac unit off, using the POWER  button.  Wait 10 seconds 

and switch it on again.  This will automatically create a new job in the log 
file. 

2. Touch the ABORT JOB  button until the display returns to the initial 
guidance mode.  This will terminate the current job and start a new job in 
the log file. 

 
 

3.3.8 Switching Off 

The Spraytrac unit must be switched off after use.  In order to avoid corruption of 
data in the system, it must always be switched off using the front panel POWER 

 button and never by interrupting the electrical supply to the unit.  To switch the 
unit off, press the POWER  button once so that it latches in the OUT position.  
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The display will show SHUTTING DOWN for about 5 seconds before the display 
and its backlight extinguish. 
 
The Spraytrac unit will start a new job each time it is switched on.  It is, therefore, 
important that it is not switched off if a job is interrupted (eg by leaving the spray 
area to refill the spay tank). 
 
 

3.3.9 Downloading of Log File 

The Spraytrac unit maintains an internal log file of the position of the vehicle and 
the spray on/off data for as long as it is switched on.  This file is stored in an 
internal non-volatile memory and is not erased when the unit is switched off.  
Each new spray job is appended to the log file as it is carried out.  The log file 
has a maximum capacity of approximately 2000 hours of logged data (2 GB 
internal memory). 
 
The log file can be downloaded to a USB flash memory key for transfer to the 
Spraymaps office based software, which allows individual spray jobs to be 
archived, viewed and printed – see section 4.  It is recommended that the USB 
memory key supplied with the system should be used.  Alternatively, any other 
USB memory key can be used, provided that it is correctly configured and has a 
minimum of 2 GB of free space. 
 
The USB memory must be formatted for a FAT32 file system and must have the 
necessary folders prepared for data transfer (see section 4.9).  Note that if a 
download is attempted using a USB memory without the necessary folders, no 
data will be transferred or lost.  This helps to prevent unauthorised download or 
deletion of the log file from the Spraytrac unit.  The procedure to download a log 
file to a USB memory key is as follows: 
1. Ensure that the Spraytrac unit is switched off. 
2. Insert the USB flash memory key into the USB socket on the cable from the 

Spraytrac unit.  Note that the flash memory key may be of the ‘thin’ type, 
without a metal casing around the connector.  This type of key has the 
advantage of being completely dust- and water-proof but it is possible to 
insert the device into the socket either way up.  The gold contact ‘fingers’ 
must face inwards towards the insulator in the socket.  No damage will be 
done if the key is inserted upside down, but the data transfer will not be 
successful. 

3. Switch on the Spraytrac unit.  The display should show DOWNLOADING 
LOG FILES, then LOG FILES TRANSFERRED and finally SWITCH OFF 
AND REMOVE USB.  In the event of an error message, see section 3.4. 

4. Switch off the Spraytrac unit and remove the USB memory key.  The log 
files will have been transferred to the USB memory and can be loaded into 
the archive using the Spraymaps program – see section 4.3. 

 
If the log file has been successfully transferred to the USB memory (ie no error 
message was displayed in step (3) above), the data in the internal log file in the 
Spraytrac unit will be deleted the next time the unit is switched on without the 
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USB memory key inserted.  Subsequent jobs will be recorded, starting with an 
empty log file and all previous jobs will be erased. 
 

IMPORTANT:  It is recommended that the Spraymaps program should be used 
to transfer the log file from the USB memory key to the job archive as soon as 
possible.  In the event of a problem with loading the file or viewing the jobs 
Spraymaps, the transfer procedure can be repeated as many times as 
necessary by repeating steps (1) – (4) above.  However, this is only possible if 
the Spraytrac unit has not been switched on without a USB memory key inserted 
since the previous (unsuccessful) download attempt. 
 
A flowchart of the log file download procedure is shown in Appendix I. 
 
 

3.3.10 Software and Configuration Update 

The internal software (firmware) of the Spraytrac unit can be updated if a new 
version becomes available.  The configuration file containing the set-up 
parameters for the Spraytrac unit (language, default settings etc) can also be 
updated as required. 
 
The procedure to update the software and/or configuration is as follows: 
1. Copy the configuration file and/or software update file to a USB flash 

memory key.  The Spraymaps program should be used to create a 
configuration file – see section 4.8.  A software update file may be supplied 
on a CD or may be sent as an e-mail attachment.  A Windows PC should 
be used to copy the file into the program folder in the USB memory. 

2. Ensure that the Spraytrac unit is switched off. 
3. Insert the USB memory into the USB socket on the cable from the 

Spraytrac unit. 
4. Switch on the Spraytrac unit.  The display should show FIRMWARE 

UPDATED and/or CONFIGURATION FILE UPDATED followed by 
SWITCH OFF AND REMOVE USB.  In the event of an error message, see 
section 3.4. 

5. Switch off the Spraytrac unit and remove the USB memory key.  The new 
firmware and/or configuration will be used the next time the unit is switched 
on without the USB key inserted.  Note that the version number of the 
firmware is shown on the display during the initial start-up of the unit.  This 
should be compared with the new version loaded to ensure that the update 
was successful. 

 
The configuration file is automatically deleted from the USB memory after it has 
been successfully transferred to the Spraytrac unit.  This prevents used 
configuration files from accumulating in the USB memory. 
 
A flowchart of the configuration update procedure is shown in Appendix I. 
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3.4 Fault Finding 

The Spraytrac unit is factory sealed and contains no user serviceable parts or 
adjustments.  Should the system malfunction, it is likely to be due to a simple 
external cause as shown below. 
 
Symptom Probable Cause Solution 
Backlight of display does 
not illuminate when 
Spraytrac unit is switched 
on. 

12 V power not reaching 
unit. 

Check battery fuse, 
wiring to vehicle battery 
and security of 15-pin 
connector to Spraytrac 
unit. 
Check connection to 
vehicle ground. 

Backlight of display 
illuminates, but with 
reduced or intermittent 
intensity.  No text visible 
on display. 

Insufficient supply 
voltage to unit (below     
9 V). 

Check voltage of vehicle 
battery, service and 
charge if necessary. 
Check condition of 
connections to vehicle 
battery terminals. 
If back-up battery pack is 
fitted, check supply from 
vehicle battery and 
condition of dry batteries 
in pack. 

Unit operates normally, 
but restarts when engine 
of vehicle is started. 

Supply voltage to unit 
falls below 9 V due to 
poor condition of vehicle 
battery or excessive load 
from starter. 

Service or replace 
vehicle battery. 
Install back-up battery 
pack. 
If battery pack is already 
installed, replace dry 
batteries. 

Backlight of display 
illuminates but either no 
text visible on display or 
display area completely 
black. 

Incorrect adjustment of 
display contrast. 

Adjust display contrast 
knob for optimum 
contrast of display. 

Display shows NO GPS 
DATA. 

No connection between 
GPS receiver and 
Spraytrac unit. 
 
 
 
 
 
 

Faulty GPS receiver. 

Check security of 15-pin 
connector to Spraytrac 
unit and 6-pin connector 
on GPS receiver cable. 
Check GPS receiver 
cable for damage. 
Replace GPS receiver 
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Symptom Probable Cause Solution 
Display shows 
ACQURING GPS (with 
moving progress bar) 
continuously. 
NB: it is normal for this 
message to appear for 1 – 
2 minutes when the unit is 
first switched on. 

GPS receiver unable to 
receive sufficient data 
from GPS satellites. 

Check that GPS receiver 
is mounted on 
unobstructed part of 
vehicle and is facing 
upwards. 
Check that vehicle is not 
under a metal roof or 
close to an obstruction – 
move vehicle as 
necessary. 

Display shows BAD 
CONFIGURATION FILE. 

Configuration file in 
Spraytrac unit is 
corrupted. 

Use Spraymaps program 
to create a new 
configuration file and 
upload to Spraytrac unit.  
See section 4.8.  The 
Spraytrac unit will 
continue to operate, but 
with a default 
configuration. 

Configuration of Spraytrac 
unit does not update from 
USB memory and no error 
message shown on 
display during attempted 
update. 

Configuration file name 
does not match Device 
ID number of Spraytrac 
unit. 
 

Configuration file located 
in incorrect folder in USB 
memory 

Use Spraymaps program 
to edit configuration file 
for the correct Device ID 
and upload to Spraytrac 
unit.  See section 4.8 
Use Spraymaps program 
to create folder and 
configuration file in USB 
memory.  See section 
4.9 

Sprayer icon on display 
does not change to show 
output from sprayer when 
sprayer switched on (only 
applicable when sprayer 
is connected to Spraytrac 
unit). 

Faulty connection 
between sprayer and 
Spraytrac unit. 
 

Incorrectly adjusted or 
faulty pressure switch on 
sprayer (if fitted) 

Check wiring to sprayer 
and security of 3-pin 
connector on sprayer 
cable. 
Adjust or replace 
pressure switch. 

Display shows LOG 
FILES EMPTY when 
attempting to download 
logs to USB memory. 

The memory of the 
Spraytrac unit does not 
contain any new log files 
(ie no files were created 
since the previous 
download). 

Download files again 
when the Spraytrac unit 
contains new job data. 
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Symptom Probable Cause Solution 
Display shows LOG 
FILES TRANSFER 
FAILED when attempting 
to download logs to USB 
memory. 

The Spraytrac unit 
cannot write log files to 
the USB memory 
because the memory is 
full, corrupted or not 
properly configured. 
USB memory formatted 
for FAT16 or NTFS, not 
FAT. 
 

USB memory faulty. 

Use Spraymaps program 
to re-initialise USB 
memory.  See section 
4.9. 
 
 
 
 

Use Windows PC to re-
format USB memory for 
FAT32 file system. 
 
 

Use a different USB 
memory (initialise with 
Spraymaps first). 

Display shows VERSION 
UPDATE FAILED when 
attempting to update 
Spraytrac firmware from 
USB memory. 

The Spraytrac unit has 
found a new version of 
the system firmware in 
the USB memory but is 
not able to use it 
because the file is 
corrupted. 

Delete the file from the 
program folder in the 
USB memory and make 
a new copy from the 
source location.  See 
section 3.3.10. 

Display does not show file 
transfer messages when 
unit is switched on with 
USB memory inserted. 

Spraytrac unit cannot 
recognise USB memory. 
 
 
 
 
 
 
 
 
 
 
 

USB memory faulty 

Check that USB memory 
is correctly inserted in its 
connector.  If a ‘thin’ type 
USB memory is used, 
check that it is correctly 
inserted (with gold 
contact areas towards 
centre of connector). 
Use a different USB 
memory (initialise with 
Spraymaps first). 
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4. SPRAYMAPS PROGRAM 
The Micronair Spraymaps program enables the user to: 
 Download and archive spray jobs, using a USB flash memory key to transfer 

data from the Spraytrac units in the vehicles. 
 Add and edit details of spray jobs. 
 View the track of the spray vehicle during a spray job and see statistics both 

for an entire job and for any point within a job. 
 Print a report sheet for a spray job.  This shows both the vehicle track and the 

job statistics. 
 Create configuration files for transfer to Spraytrac units via a USB flash 

memory key. 
 
 

4.1 Installation and Configuration 

The Spraymaps program can be installed on an office PC or a laptop computer 
running Windows 2000, Windows XP, Windows Vista or Windows 7.  The text of 
the job displays and printed reports can be in English, French or Arabic. 
 
The software is supplied on a CD.  It is recommended that the program should 
be installed using the installation program on the CD but instructions for manual 
installation are given in Appendix III.  The normal installation procedure is as 
follows (note that the PC must have an Arabic keyboard and Windows Arabic 
language support enabled if the Arabic version of Spraymaps is to be installed): 
 

 
 

1. Load the CD into the CD drive on 
the PC.  If Autorun is enabled on 
the PC, the installation menu will 
appear automatically.  Otherwise, 
double-click Menu.exe in the root 
folder of the CD.  Click a button to 
choose the language to be used in 
Spraymaps. 

 
 

2. The Setup Wizard window will 
appear.  Close any other 
Windows applications and click on 
Next.  On the next screen, accept 
the licence agreement and click 
Next again. 
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3. Select the destination folder for 
the Spraymaps program.  The 
default is C:\Program files 
\Spraymaps, but this can be 
changed (eg to a network 
location).  Click on Next.  

 
 

4. Select the location where the 
GPSArchive folder should be 
installed.  The default C:\DataDir 
can be changed (eg to C:\...\My 
Documents or a network 
location*).  Click on Next. 

 
 

5. Select the Start menu folder for 
the program shortcut or tick the 
box if a shortcut in the Windows 
Start menu is not required.  The 
default folder should normally be 
used.  Click on Next. 

 
 

6. Tick the Create a desktop icon 
box to put a Spraymaps icon on 
the desktop.  Tick the Create a 
Quick Launch icon box to add a 
button to the Windows Quick 
Launch toolbar.  Click on Next. 

 
 

7. Click on Install to install the 
program and GPS Archive folder. 

 
 

8. Click on Finish to exit the Setup 
Wizard and start Spraymaps. 

* Note that security restrictions on a Windows 7 PC can prevent the creation of a 
new folder in the root of the C: drive.  In this case, the Spraymaps program 
should be run for the first time with Administrator Privileges. 
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9. Double-click the Shortcut to Spraymaps icon on the desktop.  When the 
program starts for the first time a window will appear with the message 
Failed to find data folder...  This is normal as the location for the jobs 
archive has not yet been defined in the Spraymaps program.  Click on the 
OK button and the Options window will appear – see Fig. 14.  Click on the 
Browse button and navigate to the GPSArchive folder created in step (6) 
above.  Click on this folder to highlight it and then click on OK to close the 
Browse for Folder window.  Click on the OK button to close the Options 
window.  The main program window should open automatically. 

 

 
 

Fig. 14 – Options Window 
 
These steps complete the installation of the program and archive data folder.  
The program must be configured for user preferences before use.  The 
procedure is as follows: 
1. If not already open, start the Spraymaps program by double-clicking on its 

icon on the desktop.  The main program window is shown in Fig. 15. 
2. Click on File > Options to open the Options window – see Fig. 14. 
3. Choose the preferred system of latitude and longitude units to be used on 

the job display and in printed job reports and click on the applicable button.  
Available options are: 
- Degrees Minutes Seconds (eg N 50º 20’ 30.00”) 
- Decimal Minutes (eg N 50º 20.50’) 
- Decimal Degrees (eg N 50.3417º) 

4. Enter the time offset in the Hours from UTC box.  This is the difference 
between local time and UTC (GMT) time as used by the GPS satellite 
network.  The times recorded in the log files are UTC and the time offset is 
used to convert these to the local time shown on the job display and in job 
reports.  The time offset is positive for locations East of the meridian and is 
negative for locations to the West.  Enter an offset of 0.0 if it is preferred to 
display and print all times as UTC.  Note that the time offset is used to 
convert times in job files whilst they are being imported into the archive, not 
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when they are displayed.  For this reason, the time offset must be set 
before any jobs are imported. 

5. Check that the path shown in the Data Folder box corresponds to the 
correct location for the job archive data files. 

6. Click on OK to save the configuration options. 
7. The configuration options can be changed at any time by clicking on File > 

Options and following the above steps. 
8. Should it be necessary to change the location of the GPSArchive folder, 

the procedure is as follows: 
i. Create a new empty GPSArchive folder in the required location. 
ii. Copy all sub-folders from the original GPSArchive folder to the new 

GPSArchive folder. 
iii. Open the Options window, click on the Browse button and navigate 

to the new GPSArchive folder.  Highlight this folder and click on OK.  
Click on OK in the Options window to save the new archive location. 

iv. Open Spraymaps and check that the archive files are accessible in the 
new location. 

v. Delete the original GPSArchive folder and all its sub-folders. 
 
 
4.2 Overview of Program 

The main program window is shown in Fig 15.  By default, the window is divided 
into three panes: 
 Jobs (left hand pane).  This shows a list of all spray jobs archived in the 

system, arranged as a multi-level tree.  The tree is structured as follows: 
 

     JOBS 
 

      Vehicle Name 
 

                Year 
 

                         Month  
 

                                Date_J01 
                                Date_J02 

 
The name of each job file is in the format Date_Jxx.  Multiple jobs for the 
same vehicle on the same day are numbered J01, J02 etc in time order (ie 
J01 is the first job of the day).  The actual times are shown when the jobs are 
displayed. 
 
The tree display can be expanded by clicking on the  button at each branch 
of the tree.  Clicking on the  button collapses the branch.  A spray job is 
selected by clicking on it with the left mouse button. 
 
The Jobs pane can be resized by clicking and dragging on the right hand 
border. 
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Fig. 15 – Main Program Window 
 
 

 Map (central pane).  This shows the track of the vehicle for the selected job.  
The track is overlaid on a latitude/longitude grid.  The track is shown in blue 
when the vehicle is not spraying and in red when the sprayer is turned on.  
Note that the Spraytrac unit in the vehicle must be connected to the sprayer 
for spray on/off information to be recorded and displayed. 
 
Initially, the map display will be scaled so that the entire track fits into the 
Map pane.  The display can be zoomed in and out by pressing the + or – 
keys on the numeric keypad.  On a laptop computer without a numeric 
keypad, the display can be zoomed with the i (in) or o (out) keys.  If the PC is 
provided with a mouse with a scroll wheel, the wheel can also be used to 
zoom the display.  Note that it is only possible to zoom the map display whilst 
the Map pane is active.  If the zoom controls do not work as expected, move 
the mouse cursor anywhere within the Map pane and left click to bring focus 
to the pane and activate the controls.  The track can be moved (panned) 
within the Map pane by positioning the mouse cursor anywhere in the pane, 
holding down the left mouse button and dragging the image with the mouse 
or trackpad.   
 
The left and right hand borders of the Map pane can be moved by positioning 
the mouse cursor on a border, holding down the left mouse button and 
dragging the border horizontally. 
 
The Map pane is always active and cannot be hidden. 
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 Properties (right hand pane).  This pane is divided into two sections.  The 
upper section shows the parameters for the spray job that is selected in the 
Jobs pane.  Information shown is as follows: 
Vehicle Name The name of the vehicle as configured in the Spraytrac unit. 
Location The location of the spray job (if entered manually). 
Driver The name of the driver (if entered manually). 
Wind Velocity The wind speed at the spray site (if entered manually). 
Wind Dir The wind direction at the spray site (if entered manually). 
Product The type of pesticide used (if entered manually). 
Volume Used The volume of pesticide used for the job (if entered 

manually). 
Start Date The date on which the job was started (from GPS data). 
Start Time The time at which the job was started (from GPS data, 

corrected to local time). 
End Date The date on which the job was completed (from GPS data). 
End Time The time at which the job was completed (from GPS data, 

corrected to local time). 
Start Position The position of the vehicle at the beginning of the spray job 

(from GPS data). 
Track Spacing The track spacing entered into the Spraytrac unit and used 

for the spray job (from the Spraytrac unit). 
Spray Time The total time for which the sprayer was turned on during 

the job (recorded by the Spraytrac unit, but only valid if the 
unit was connected to the sprayer, shown as 0.00 
otherwise). 

Av Speed The average speed of the vehicle whist spraying (calculated 
from the speeds recorded by the Spraytrac unit, but only 
valid if the unit was connected to the sprayer, shown as 0.0 
otherwise). 

Area Sprayed The total area sprayed for the spray job (calculated from the 
vehicle speed and track spacing whilst spraying, but only 
valid if the unit was connected to the sprayer, shown as 0.00 
otherwise). 

Volume/Area The average application rate (litres/ha) on the area sprayed 
during the job (calculated from the Volume Used and Area 
Sprayed, but only valid if the Volume Used had been 
entered manually and the Spraytrac unit had been 
connected to the sprayer, shown as 0.0 otherwise). 

Information shown as entered manually will only be displayed if the job 
details have already been entered or edited as described in section 4.4. 

 
The lower section of the Properties pane shows information about the job at 
any position selected by the user.  To display this information, click on any 
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part of the vehicle track in the Map pane.  An arrow will appear at the 
selected point on the track to indicate the direction of travel and the 
information in the lower section of the Properties pane will update to show the 
position, speed, sprayer status (on/off), track spacing, date and time at the 
selected point.  This information will be displayed until a new point is clicked. 

 
The Properties pane can be toggled on and off by clicking on the  button on 
the toolbar at the top of the window or by clicking on View > Show 
Properties. 

 

4.3 Archiving of Job Files 

Data logged by Spraytrac units is transferred to the Spraymaps program on a 
USB flash memory key.  The same memory key can be used to download data 
from Spraytrac systems on multiple vehicles.  The only limitation on the number 
of log files that can be held in one key at the same time is that the combined size 
of the files must not exceed the capacity of the USB memory.  As a guide, one 
hour of logged data will occupy approximately 1 MB, so a 2 GB USB memory 
can hold log files for jobs totalling about 2000 hours. 
 
The Spraymaps program reads log files from the USB memory and divides these 
into individual jobs for each vehicle.  The job files are then stored in the job 
archive (GPSArchive) folder on the local PC or in the selected network location.   
 
The structure of the archive is as shown in section 4.2.  The program uses the 
following criteria to divide the log file for each vehicle into individual jobs: 
- The job starts on a later date than the preceding job; or 
- the Spraytrac unit was switched off and on again on the same day; or 
- the user pressed the  button on the Spraytrac unit to terminate one job and 

to start another. 
 
Note that if the Spraytrac unit is switched on significant time before the vehicle 
first moves, or if the unit is left switched on after a spray job has finished and the 
vehicle remains stationary, the log file contains a large number of redundant 
records at the beginning and/or the end of the job.  The Spraymaps program 
automatically removes these redundant records so that the job file only shows 
the track of the vehicle from the time that it starts moving until it stops at the end 
of the job.  Records showing the vehicle as stationary during a job are not 
removed.  Should the Spraytrac unit be switched on and off again whilst the 
vehicle remains stationary (ie there is no movement whilst the unit is switched 
on), the job file contains no useful information and it is automatically discarded. 
 
The procedure to transfer job files to the archive is as follows: 
1. Download the log file(s) from the Spraytrac unit(s) on the vehicle(s) into the 

USB flash memory key as described in section 3.3.9. 
2. Start the Spraymaps program. 
3. Insert the USB memory key in any empty USB port on the PC.  If Windows 

displays a pop-up list of actions for the files on the USB memory, close the 
pop-up window. 
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4. Start the data import process by one of the following: 
- Click on the Import button  on the toolbar at the top of the screen; or 
- click on File > Import New Data; or 
- use the keyboard shortcut Ctl-N (hold down the Ctrl key and press N). 

5. An Open Files window will appear with a standard Windows directory tree 
display.  Browse to the location of the USB flash memory key (normally 
shown as Removable Disk (X:), where X is the drive letter of the device). 

6. Double-click on the USB memory entry (eg Removable Disk (X:)) and then 
double-click on the logs sub-folder. 

7. The Open Files window will show the logs sub-folder with a list of log files 
in the format name_data.log, where name is the name of each vehicle. 

8. Click on the first name_data.log file to highlight it and then click on the 
Open button. 

9. An Import Job window will open with all the jobs in the log file listed in the 
box at the left hand side of the window – see Fig. 16.  Left-clicking on a job 
will highlight it and its parameters will be displayed in the window.  
Parameters read from the job file are displayed in the lower part of the 
window.  These are shown against a grey background as they cannot be 
changed.  Parameters in the right hand side of the window are initially blank 
because the relevant information must be entered manually.  If required, 
these parameters can be entered as follows: 

i. Click on the job for which parameters are to be entered. The job will 
be highlighted and existing parameters will be displayed in the grey 
boxes. 

ii. Click in the Location box and enter the spray block location as text. 
iii. Click in the Driver box and enter the name of the driver as text. 
iv. Click in the Product box and enter details of the pesticide as text. 
v. Click in the Vol Used box and enter the volume of pesticide used for 

the job in litres.  This must be entered as a number only.  The entry 
will be stored to one decimal place (eg if 32.123 is entered, the 
volume will be stored as 32.1). 

vi. Click in the Temp box and enter the air temperature in the spray 
area in degrees C.  This must be entered as a number only, with no 
degree symbol or letter (eg 28, not 28º or 28ºC). 

vii. Click in the Wind Vel box and enter the wind speed in the spray area 
in m/sec.  This must be entered as a number only.  The entry will be 
stored as a whole number, without any decimal fraction. 

viii. Click in the Wind Dir box and enter the wind direction in the spray 
area in degrees.  This must be entered as a number only, with no 
degree symbol.  A direction entered as letters will not be stored (eg 
both 45 and 045 are acceptable but 45º or NE are not). 

ix. Click on the next spray job and repeat steps (ii) – (ix). 
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Note that it is not essential to enter all (or any) of the above parameters.  
However, the Volume/Area parameter in the job display and printout will 
only be calculated if the volume of pesticide is entered in the Vol Used box. 

10. Finally, click on the Save button to save all job files, together with any 
manually entered parameters, to the archive.  Note that this button should 
not be clicked until after the parameters have been entered for all jobs in 
the log file.  Should the files be saved before all the parameters have been 
entered, they can be edited later – see section 4.4. 

11. Repeat (8) – (10) for the log file corresponding to name of each vehicle for 
which a log file is stored on the USB flash memory. 

12. Click on the Unplug or Eject Hardware icon in the Windows system tray at 
the bottom of the screen and follow the instructions to stop and remove the 
USB memory key from the PC.  Do not remove the USB key without 
stopping it first.  Failure to follow this procedure could result in corruption of 
the log files and other data in the memory key. 

13. View each of the new job files in the archive to check that it has been 
downloaded successfully.  See section 4.6. 

 
There is no need to delete log file(s) from the USB memory key after they have 
been successfully archived by the Spraymaps program.  A log file will be 
automatically over-written the next time data is downloaded from the 
corresponding Spraytrac unit.  
 

IMPORTANT:  Should any problems be encountered whilst archiving the log files 
(eg due to corruption of the USB memory key), the files can be downloaded 
again from the Spraytrac unit(s).  However, this will only be possible if the 
Spraytrac unit(s) have not recorded any new log files in the meanwhile.  It is 
therefore strongly recommended that the job files should be archived using the 
Spraymaps program immediately after they have been downloaded from the 
Spraytrac unit(s).  In the event of a problem with data transfer using the USB 
memory key, it is recommended that the memory should be re-initialised as 
described in section 4.9.  If the problem persists, a different USB memory should 
be used.  This should be initialised before it is used to download data from the 
Spraytrac units. 
 
 
 

4.4 Editing Job Details 

The manually entered parameters for a spray job can be added or edited after 
the job has been added to the archive.  The procedure is as follows: 
1. Click on the job in the Jobs pane.  The job will be highlighted. 
2. Either click on the Edit button  on the toolbar at the top of the window or 

click on File > Edit Job.  The Edit Job Details window will appear – see 
Fig. 16. 
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Fig. 16 – Job Details Window 
 

3. Follow the same procedure as described in section 4.3, step (9) to add or 
edit parameters.  Existing parameters can be deleted or overtyped as 
required, but note that only the parameters in white boxes can be edited.  
The parameters in the grey boxes are automatically generated by the 
Spraytrac unit and cannot be changed. 

4. Click on Save to save the edited job file to the archive. 
 
 

4.5 Deleting Jobs 

Jobs can be deleted from the archive as follows: 
1. Click on the job to be deleted in the Jobs pane.  It will be highlighted. 
2. Either click on the Delete  button on the toolbar at the top of the window 

or click on File > Delete Job.  A Delete? confirmation window will appear 
with the name of the job file to be deleted. 

3. Check that the correct job is shown and click on Yes.  This will delete the 
job from the archive and it will disappear from the tree in the Jobs pane.  
Note that deleting a job will not affect the numbering of other jobs in the 
archive for the same vehicle on the same day.  For example, if the archive 
contains jobs ....J01 – ....J04 and job ....J03 is deleted, the numbers of jobs 
....J01, ....J02 & ....J04 remain unchanged. 

 

IMPORTANT:  After a job has been deleted from the archive, it cannot be 
recovered.  It is strongly recommended that the entire GPSArchive folder should 
be backed up regularly. 
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4.6 Displaying and Reviewing Jobs 

The procedure to display a spray job is as follows: 
1. Select the job from the tree display in the Jobs pane at the left hand side of 

the program window.  If necessary, the tree can be expanded by clicking on 
the  buttons alongside the relevant Vehicle Name, Year and Month 
branches.  Select the job by clicking on it with the left mouse button.  This 
causes the job name to be highlighted. 

2. The track of the sprayer appears in the central Map pane.  To see the 
vehicle track in more detail, the display can be zoomed or panned as 
described in section 4.2. 

3. The A – B line for the spray job can be toggled on and off by clicking on the 
Show AB Line  button on the toolbar at top of the window or by clicking 
on View > Show AB Line.  The A – B line is shown as a thick blue line and 
the theoretical parallel tracks are shown as thin blue lines.  The spacing 
between the lines corresponds to the track spacing set at the start of the 
spray job.  The lines can be used to compare the actual tracks of the 
vehicle with the intended tracks.   

4. A ruler tool is provided to measure the distance between any two points in 
the map display.  The tool is toggled on and off by clicking on the Show 
Ruler  button on the toolbar at top of the window or by clicking on View > 
Ruler.  When the ruler is active the mouse cursor changes from an arrow to 
a cross.  To measure the distance between two points: position the cross 
over the first point and left-click, then drag the cross to the second point.  A 
red line will be drawn between the two points and the distance will be 
shown in metres.  Left-clicking again will release the cross cursor from the 
end of the line.  The procedure can then be repeated to measure other 
distances. 

5. The latitude and longitude co-ordinates of the mouse cursor are displayed 
in the lower left hand corner of the Spraymaps window.  The co-ordinates of 
any point on the vehicle track can be shown by positioning the cursor over 
the point (without clicking the mouse). 

6. Job details appear in the right-hand Properties pane.  If necessary, user-
entered parameters can be added or edited as described in section 4.4. 

7. The Properties pane can be toggled on and off by clicking on the  button 
on the toolbar at the top of the window or by clicking on View > Show 
Properties.  This allows a greater area of the program window to be used 
to display the vehicle track. 

8. Another job can be displayed by clicking on its name in the tree in the Jobs 
pane. 

 
 

4.7 Printing Job Reports 

Spraymaps provides an option to print a hard copy of the currently displayed job.  
The printed job report shows the vehicle track and job parameters – see Fig. 17.  
The procedure to print a job report is as follows: 



38 

MICRONAIR SPRAYTRAC GPS TRACK GUIDANCE SYSTEM 

 
 

 
 

 

Fig. 17 – Printed Job Report 
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1. Select and display the job as described in section 4.6. 
2. Click on the Print Preview  button in the toolbar at the top of the window 

on click on File > Print Preview to see a preview of the printed page.  If the 
zoom level and position of the spray track on the preview are correct, the 
report can be printed directly from the preview window by clicking on the 
Print button. 

3. If it is preferred to change the zoom level and/or position of the track, click 
on the Close button, use the zoom and pan controls to adjust the track 
display and repeat step (2). 

4. Further copies of the job report can be printed directly from the Spraymaps 
window by clicking the Print  button in the toolbar at the top of the 
window or by clicking on File > Print. 

 
If a colour printer is used, the vehicle track will be printed in blue where the 
vehicle is not spraying and in red where the sprayer is operating.  If a 
monochrome printer is used, points at which the vehicle is not spraying are 
shown by grey + symbols and points at which the sprayer is operating by darker 

 symbols. 
 
 

4.8 Configuration File 

The Spraytrac unit uses a configuration file to set user-defined parameters.  To 
simplify the operation of the Spraytrac unit (and to eliminate the possibility of 
inadvertent changes by the operator), the configuration file can only be changed 
by uploading a new version from a USB flash memory key. 
 
Every Spraytrac unit has a unique identification number (Device ID).  This is a 
sixteen-digit number assigned to the unit during production.  This number cannot 
be changed.  The Device ID is shown on a label attached to the rear of the unit.  
The user must also give a unique name (corresponding to the vehicle number, 
registration etc) to each unit.  The name is defined in the configuration file. 
 
Every configuration file is unique and is automatically named after the Device ID 
of the Spraytrac unit into which it will be uploaded.  A new configuration file must 
be created for each unit to be configured. 
 
The procedure to create a new configuration file is as follows: 
1. Open the Spraymaps program and click on File > Config.  This will open 

the Configuration File Maintenance window as shown in Fig. 18. 
2. Insert a USB flash memory key in an available USB port on the PC.  Note 

that the memory should already have been initialised as described in 
section 4.9. 

3. Click on the Create Config button.  This will open a standard Windows 
Browse for Folder tree display. 
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Fig. 18 – Configuration File Maintenance Window 
 
 
4. Locate the USB flash memory (typically Removable Disk (X:) under the 

My Computer branch of the tree.  Expand the tree if necessary to show the 
config folder in the USB memory.  Click on the config folder to highlight it 
and then click on OK to confirm the location for the file and to close the 
Browse window. 

5. The window shows twelve configuration parameters.  Of these, the upper 
five are in white boxes and can be edited immediately.  The lower seven 
parameters are initially displayed in grey (non-editable) boxes and should 
only be changed by advanced users.  However, these advanced 
parameters can be made editable by clicking on the Advanced Options 
button at the bottom of the window.  All parameters can be changed to their 
default values by clicking on the Set Defaults button at the bottom of the 
window. 

 
Configuration parameters must be entered in the boxes as follows (note 
that no boxes can be left blank and * denotes advanced options): 

Device ID The sixteen-digit identification number shown on the 
label on the back of the Spraytrac unit to be configured.  
This number must consist of exactly sixteen digits and 
cannot consist of all zeros.  It is recommended that the 
number should be entered by over-typing the default 
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string of zeros.  The number can be re-set to all zeros 
by clicking on the Default button alongside the number.  
Note that the configuration file will only be recognised 
by the Spraytrac unit corresponding to the Device ID 
used in name of the configuration file.  The file will be 
ignored by all other units. 

Name A user-assigned name for the vehicle.  The name 
should be unique and easily recognised (the vehicle 
number, registration, etc).  This name will be used to 
identify the vehicle in the job archive and the 
Spraymaps job display.  The name can include letters 
and numbers, but should not contain any spaces or 
other characters (*, /, &, ? etc).  However, an 
underscore character (_) can be used instead of a 
space. 

Language The language and numeric format to be shown on the 
Spraytrac display.  One of four language options must 
be selected from the drop-down list (click on the 
downward-pointing arrow to select).  Available options 
are: 
English English language text and numerals in 
Western script with a dot as the decimal separator (eg 
123.4). 
French French language text and numerals in 
Western script with a comma as the decimal separator 
(eg 123,4). 
Arabic 1 Arabic language text and numerals in Hindi  
script with a comma as the decimal separator (eg 
١٢٣,٤). 
Arabic 2 Arabic language text and numerals in 
Western script with a comma as the decimal separator 
(eg 123,4). 

Track Spacing The initial track spacing (in m) to be used by the 
Spraytrac unit.  The track spacing can be changed later 
by the operator as required. 

Lat/Long Format The format of the GPS co-ordinates shown on the 
Spraytrac display.  One of two options must be 
selected from the drop-down list (click on the 
downward-pointing arrow to select).  Available options 
are: 
Deg:Min:Sec Degrees, minutes and seconds,      
eg N 50:20:30 (N 50º 20’ 30”) 
Decimal Degrees Decimal degrees to 4 places,       eg 
N 50.3417 (N 50.3417º) 
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Note that this parameter determines the format of the 
Spraytrac display only.  The format of co-ordinates 
shown in the Spraymaps program is set from within 
Spraymaps. 

Min Speed* The minimum speed of the vehicle at which the 
Spraytrac unit provides track guidance.  This must be 
high enough to avoid ambiguous operation whilst the 
vehicle is manoeuvring very slowly and be low enough 
to ensure guidance at low spraying speeds.  The speed 
should only be changed from the default of 2 km/hr if 
the vehicle is driven at an unusually low speed during a 
spray job. 

Min AB Distance* The minimum distance (in m) between the points 
representing the beginning of the first spray track (point 
A) and the end of the first track (point B).  The 
Spraytrac unit will not allow the operator to define point 
B until the vehicle has moved the minimum distance 
from point A.  This distance should not be changed 
from the default of 20 m unless the spray lines are 
unusually short. 

Ret Point Rad* The distance (radius) from a marked return point at 
which the Spraytrac display changes from orientation 
to track guidance mode.  When the vehicle returns to a 
previously marked return point, the display is initially in 
orientation mode and shows the location of the point 
relative to the vehicle.  When the vehicle reaches the 
distance from the return point defined by Ret Point 
Rad, the display changes to track guidance mode and 
shows the desired and adjacent spray tracks.  The Ret 
Point Rad should not be set to a distance of more than 
five times the minimum anticipated track spacing.  This 
ensures that at least one adjacent spray track will be 
visible on the Spraytrac display when changing to track 
guidance mode.  Setting a higher figure could result in 
a completely blank track guidance display. 

Button Delay* The time (in seconds) for which a button on the 
Spraytrac unit must be touched before the system 
responds.  Setting this time too low can result in 
inadvertent operation if a button is touched 
accidentally.  Setting the time too high can make the 
system excessively slow to respond. 

Button Repeat* The rate (in counts/second) at which the track spacing 
increments or decrements whilst the  or  buttons 
are touched for an extended time.  Note that the track 
spacing will initially increment or decrement four times 
at a rate determined by the Button Delay and will then 
increment or decrement more quickly at a rate 
determined by Button Repeat.  Setting the repeat rate 
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too high can result in over-shooting the desired figure 
and setting it too low can make the process of setting 
the track spacing excessively slow. 

LCD Contrast* A factory-set parameter that controls the adjustment 
range of the display contrast knob on the Spraytrac 
unit.  This should not be changed. 

LCD Bias* A factory-set parameter that controls the configuration 
of the LCD display on the Spraytrac unit.  This should 
not be changed. 

6. When all parameters have been entered, click on the Save Config button 
at the bottom of the window to save the file in the location selected in step 
(4) above.  The file name will be in the format 0000000000000123.cfg, 
where the number corresponds to the Device ID. 

 
An existing configuration file can be edited as follows: 
1. Click on the Edit Config button at the top of the window.  This will open a 

normal Windows Browse for Folder tree display.  Locate the USB flash 
memory (typically Removable Disk (X:)) under the My Computer branch 
of the tree.  Expand the tree if necessary to show the system folder in the 
USB memory.  Expand the tree if necessary to show the config folder 
under system.  Click on the configuration file to be edited.  The file name 
(in the format 0000000000001234.cfg) will be highlighted. 

2. Click on Open to open the file in the Configuration File Maintenance 
window. 

3. Edit the file as required and click on the Save Config button to save the 
file. 

 
Note that the name of the file saved is based on the device ID.  This allows 
multiple configuration files containing similar parameters to be created for 
several Spraytrac units very easily.  The procedure is as follows: 
1. Use the Create Config option to create and save the configuration file for 

the first Spraytrac unit. 
2. Use the Edit Config option to change only the Device ID and Name 

parameters in the file.  Save the file.  The file will be saved with a new 
name corresponding to the new Device ID. 

3. Repeat step (2) to create a configuration file for each Spraytrac unit. 
 
An unwanted configuration file can be deleted from the USB memory as follows: 
1. Click on the Delete Config button at the top of the window.  This will open 

a normal Windows Browse for Folder tree display.  Locate the USB flash 
memory (typically Removable Disk (X:)) under the My Computer branch of 
the tree.  Expand the tree if necessary to show the system folder in the 
USB memory.  Click on the System folder and then click on the 
configuration file to be deleted.  The file name (in the format 
0000000000001234.cfg) will be highlighted. 
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2. Click on the Open button.  A Confirm window will appear.  Click on Yes to 
confirm deletion of the file.  Note that a file deleted from within Spraymaps 
cannot be recovered. 

 
 

4.9 Preparation of USB Flash Memory Key 

A standard USB flash memory key is used to transfer log files from Spraytrac 
units in vehicles to the Spraymaps program on a PC.  The same USB memory is 
used to transfer new configuration files or updated firmware to the Spraytrac 
units. 
 
Although not essential, it is strongly recommended that the USB flash memory 
supplied with the system is kept for this purpose only and that it is not used to 
store other files unrelated to the Spraytrac/Spraymaps system.  This avoids any 
risk of the memory being corrupted by other applications. 
 
The USB memory must be formatted for the FAT32 file system (the memory 
supplied is already formatted for FAT32).  The Spraytrac unit will show an error if 
the memory is formatted for the alternative Windows FAT16 or NTFS file 
systems. 
 
Data is stored in folders in the USB memory.  The folders are structured as 
follows: 
 

     USB MEMORY DEVICE 
 

      logs 
 

                Log files 
 

      config 
 

                Configuration files 
 

      program 
 

                Program (firmware) files 
 

Note that the folder names must be in all lower case characters (eg logs and not 
Logs or LOGS). 
 
The folders (logs, config & program) must be created in the USB memory before 
it is used to transfer data.  Spraymaps provides a utility to initialise a USB 
memory by creating the necessary folders automatically.  The procedure to 
initialise a USB memory key is as follows: 
1. Insert the USB memory in an available USB port on the PC. 
2. If necessary, format the memory for the FAT32 file system (right-click on 

the device in My Computer or Windows Explorer and select Format > 
FAT32).  Note that formatting will destroy all data in the USB memory. 

3. Start Spraymaps and click on File > Initialise USB.  This will open a 
command window. 
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4. Enter the drive letter corresponding to the USB memory.  The folders (if 
any) already in the memory will be displayed. 

5. Enter Y to confirm that the program is working with the correct device or N if 
an incorrect drive letter has been entered. 

6. If any of the folders used by the system already exist in the memory, the 
program will display a warning that they will be deleted (any other folders 
will remain).  Enter Y to delete the original folders and data.  The program 
will create new folders and will display USB Flash Drive Configured. 

7. Press any key to return to the main Spraymaps window. 
8. Click on the Unplug or Eject Hardware icon in the Windows system tray at 

the bottom of the screen and follow the instructions to stop and remove the 
USB memory key from the PC.  Do not remove the USB key without 
stopping it first.  Failure to follow this procedure could result in corruption of 
the log files and other data in the memory key. 
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5. PARTS LIST 
When ordering spare parts, please specify the following information: 
 
 Serial number of system unit 
 Approximate date of purchase 
 Description of part 
 Part number as shown in this section 
 Number of parts required 

 
 
 
Item Part No Description    Notes 
 
1 EX7118 Spraytrac system unit  With mounting bracket 
2 EX7119 Mounting bracket 
3 EX7129 Cable assembly 
4 EX7128 GPS receiver    With cable & connector 
5 EX7131 Battery cable    With fuse 
6 EX7136 Back-up battery pack  Supplied without batteries 
7 EX7135 USB flash memory key (2 GB) Supplied formatted 
8 EX7142 Software CD 
9 EX7143 Storage case    With foam insert 
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6. CONVERSION FACTORS 
 
1 yard   = 3 feet   = 0.91 metre 
1 metre  = 39.37 inches  = 1.09 yards 
1 statute mile  = 0.87 nautical mile  = 1.61 kilometres 
1 nautical mile = 1.15 statute mile  = 1.85 kilometres 
1 kilometre  = 0.62 statute mile  = 0.54 nautical mile 
1 statute mile  = 1760 yards   = 5280 feet 
1 nautical mile = 2027 yards   = 6081 feet 
1 kilometre  = 1094 yards   = 3282 feet 
1 metre/sec  = 2.237 miles per hr  = 196.9 ft/min 
 

1 acre   = 43560 sq feet  = 4840 sq yards 
1 acre   = 4047 sq metres  = 0.40 hectare 
1 hectare  = 107600 sq feet  = 11955 sq yards 
1 hectare  = 10000 sq metres  = 2.47 acres 
1 sq mile  = 640 acres   = 259 hectares 
1 sq kilometre = 247 acres   = 100 hectares 
 

1 US gal  = 0.83 Imp gal  = 3.78 litres 
1 Imp gal  = 1.20 US gals  = 4.54 litres 
1 litre   = 0.26 US gal  = 0.22 Imp gal 
1 US pint  = 16 US fl ounces  = 0.47 litres 
1 Imp pint  = 20 Imp fl ounces  = 0.57 litre 
 

1 US gal/acre = 8 US pint/acre  = 9.45 litres/hectare  
1 Imp gal/acre = 8 Imp pints/acre  = 11.35 litres/hectare 
1 litre/hectare = 0.11 US gal/acre  = 0.081 Imp gal/acre 
 

1 pound  = 16 ounces   = 0.45 kilogram 
1 kilogram  = 2.20 pounds  = 35.3 ounces 
1 ounce  = 28.35 grams 
 

1 pound/sq inch = 0.068 atmosphere  = 0.067 bar 
1 atmosphere = 14.70 pounds/sq in = 1.01 bar 
1 bar   = 14.50 pounds/sq in = 0.98 atmosphere 
1 kilopascal = 0.01 bar = 0.145 pounds/sq in 
 
 
 

Micronair is the registered trademark of Micron Sprayers Limited, Bromyard, 
Herefordshire, United Kingdom.  All other trademarks used in this Handbook are 
the property of their respective owners. 
 
Every care has been taken in the design of this equipment and the preparation of 
this Handbook.  However, Micron Sprayers Limited cannot accept responsibility 
for errors or the consequences thereof.  The user must satisfy himself that the 
equipment is suited to his needs, is performing according to his requirements 
and that all relevant regulations are being complied with. 
 
Spray jobs shown in the Handbook are simulated.  The co-ordinates shown do 
not correspond to actual spray operations. 
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APPENDIX I  –  FLOWCHARTS 
 
 
1. Transfer of Log File to USB Flash Memory 
 
 
 

INSERT USB FLASH
MEMORY

IS THERE
A LOG FILE TO
DOWNLOAD?

SWITCH ON SPRAYTRAC
UNIT

SHOW MESSAGE: LOG
FILES EMPTY

COPY LOG FILE TO USB
FLASH MEMORY

SWITCH OFF SPRAYTRAC
UNIT

SWITCH ON SPRAYTRAC
UNIT

USB FLASH
MEMORY

INSERTED?

DELETE LOG FILE IN
SPRAYTRAC  UNIT

ENTER TRACK GUIDANCE
MODE

YES

YES

NO

NO
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2. Update of Firmware & Configuration File 
 
 
 

INSERT USB FLASH
MEMORY

IS THERE
A FIRMWARE UPDATE

FILE?

SWITCH ON SPRAYTRAC
UNIT

SHOW MESSAGE: SWITCH
OFF AND REMOVE USB

UPDATE SPRAYTRAC
FIRMWARE

SHOW MESSAGE:
FIRMWARE UPDATED

DELETE CONFIGURATION
FILE IN USB MEMORY

IS THERE A
CONFIGURATION

UPDATE FILE?

UPDATE SPRAYTRAC
CONFIGURATION

SHOW MESSAGE:
CONFIGURATION UPDATED

YES

YES

NO

NOUPDATE
SUCCESSFUL?

SHOW MESSAGE:
UPDATE FAILED

YES

NO
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APPENDIX II  –  ARABIC SCREEN TEXT 
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APPENDIX III  –  MANUAL PROGRAM INSTALLATION 
 
 
It is recommended that the Spraymaps program and folders should normally be 
installed using the Setup Wizard on the CD as described in section 4.1.  Should 
it be necessary to install the program manually, the procedure is as follows: 
1. Load the CD into the CD drive on the PC. 
2. Using Windows Explorer (or by clicking My Computer > System (C:) > 

File > New), create a folder named Spraymaps at C:\Program 
Files\Spraymaps (or at a different location if required). 

3. Copy the file Spraymaps.exe from the Program folder on the CD to the 
…\Spraymaps folder created in step (2). 

4. Decide whether the program is to show English or French language text. 
- For English: Copy the Strings.cfg file from the Program\English 

folder on the CD to the …\Spraymaps folder on the PC. 
- For French: Copy the Strings.cfg file from the Program\French 

folder on the CD to the …\Spraymaps folder on the PC. 
5. Right-click on Spraymaps.exe and select Create Shortcut from the menu.  

Drag the shortcut from the folder onto the desktop. 
6. Decide on the location for the folder to hold the archive of spray jobs.  On a 

stand-alone PC this could be C:\DataDir or C:\Documents and 
Settings\[Username]\My Documents.  Alternatively, the folder could be 
located on a network server or NAS drive.  Regardless of the location 
chosen, it must be accessible via a drive letter on the local PC and should 
be in a part of the directory structure that is backed up regularly. 

7. Using Windows Explorer (or by clicking My Computer > System (C:) > 
File > New), create a folder named GPSArchive (with no space in the 
name) at the chosen location. 

8. Remove the CD from the drive on the PC. 
9. Start the Spraymaps program and configure the location of the GPS 

Archive folder as described in section 4.1, step (9). 
 
 



  

  

 


